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Introduction 
 
Welcome to Velsoft’s courseware for Microsoft Office Word 2010, Microsoft’s flagship word 
processing software. This new version of Word incorporates many new features and 
connectivity options in efforts to make collaboration and production as easy as possible. 
 
This Advanced level is intended to help users who are already proficient with Word become 
more familiar with adding various types of objects to their documents. If you are an instructor, 
gauge the comfort level your students have with using a computer; you may be able to skip 
over some easy components. 
 
This manual will cover pictures, shapes, text boxes, WordArt, SmartArt, Building Blocks, Quick 
Parts, tables, and charts. By the end of this manual, users should be completely comfortable 
inserting and manipulating these objects. 
  
This manual was created using Microsoft Office 2010 Professional Plus. Our test machine was a 
64-bit computer running Windows 7 Business Professional. Any feature specific to Windows 7 
in this manual will be marked as such. 
 
Occasionally, this manual may reference where certain keys are on the keyboard (such as 
Insert, Home, or Page Up). The directions are given based on a standard desktop keyboard that 
contains a separate number pad. Laptop keyboards may be different or have combined keys. 

Prerequisites 
This manual presumes that the user has a basic knowledge of Windows, including concepts 
such as using the mouse and keyboard. It also presumes that the user has completed the 
Intermediate level of this course (or has equivalent knowledge) and is familiar with concepts 
such as saving files in various formats, using templates, working with sections, and performing 
basic and advanced text formatting. 
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Section 1: Working with Pictures 
 

 
In this section you will learn how to: 

 Add a picture from a file 
 Add Clip Art and screenshots 
 Use the Picture Tools – Format tab 
 Use the mini toolbar for pictures 
 Perform basic editing tasks on pictures 
 Resize, move, arrange, group, and ungroup pictures 
 Wrap text around pictures in different ways 
 Change the picture’s position on the page 
 Crop pictures in different ways 
 Rotate, flip, align, and distribute pictures 
 Sharpen and soften pictures 
 Change the brightness, contrast, saturation, and tone of pictures 
 Recolor pictures 
 Apply artistic effects and picture styles to images 
 Add borders and effects to pictures 
 Edit the background of a photo 
 Use the Format Picture dialog 
 Compress pictures 
 Change a picture while preserving the formatting 
 Reset pictures 
 Save pictures outside of Word 
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Lesson 1.1: Inserting Pictures 
 

 
Welcome to the Microsoft Office Word 2010 courseware! In this advanced level, we’ll go above 
and beyond creating basic documents. You’ll learn many ways to present information and make 
your documents more appealing than ever. 
 
To start out, we will look at different types of images that you can add to documents: pictures, 
Clip Art, and screenshots. We’ll also look at some contextual picture tools. 

Inserting a Picture from a File 
 
To insert a picture from a file on your computer, click the Insert tab and click Picture:  
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You will then be prompted to locate and choose the file. Click a single file or hold Ctrl and click 
multiple files. Click Insert when you’re ready: 
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The picture will then be added to your document and resized (if necessary) to fit the page. The 
Picture Tools – Format tab will also become available: 

 

 

Inserting Clip Art 
 
If you don’t have a picture on your computer to use, you can check the picture collections 
included with Microsoft Office. To start, click Insert – Clip Art: 
 

 
 

To search for Clip Art, type what you’re looking for in the search box. (If you like, you can also 
choose what type of file you want.) Once you’re ready, click Go:  
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You will then see images appear in the white part of the task pane. Once you’ve found the 
image you’re looking for, simply click to place your cursor where you want the image to go in 
the document. Then, right-click the image and click Insert: 
 

 
 
Notice that you also have commands to copy the photo to the clipboard, delete the photo from 
the Clip Organizer (if it is located on your computer), make the photo available offline (if the 
photo has been downloaded from Office Online), move the photo (if it is located on your 
computer), edit the keywords, and preview the image and view its properties. 
 
Once you have inserted Clip Art, the image will be placed in your document and selected. (Clip 
Art can be either a shape or an image, so Word will provide the appropriate tools to edit it – 
either the Picture Tools or Drawing Tools Format tab.) 
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Adding a Screenshot 
 
Word 2010 now offers the ability to add screenshots (pictures of things on your computer 
screen) to documents. To start, make sure that the window that you want to take a picture of is 
maximized. Then, bring up Microsoft Word, click Insert, choose Screenshot, and click the 
window that you want to take an image of:  
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The image will then be inserted into your document at the position of your cursor: 
 

 
 
You can now work with the screenshot as you would any other image. 

Overview of the Picture Tools – Format Tab 
 
You’ve seen that when you add any type of picture to your document, you will see the Picture 
Tools – Format tab: 
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Let’s review its options. (Note that this topic is just an introduction to the commands. We’ll 
explore how to use most of the commands during this section.) 
 
Adjust Group 
The commands in this group allow you to modify the contents of the picture. 
 

 

Opens the Background Removal tab, which provides tools to remove 
parts of the picture’s background. This is a very cool new feature that we 
will explore later on in this section.  

 Opens a menu with commands to sharpen or soften the picture, or 
change brightness and contrast. The Picture Corrections Options 
command at the bottom of the menu opens that tab of the Format 
Picture dialog. 

 Opens a menu with commands to adjust the saturation and tone of the 
image or recolor the picture. You can also make a particular color in the 
image transparent. The Picture Color Options command at the bottom 
of the menu opens that tab of the Format Picture dialog. 

 Opens a menu with thumbnails of artistic effects that can be applied to 
the photo. The Artistic Effects Options command at the bottom of the 
menu opens that tab of the Format Picture dialog. 

 Opens the Compress Pictures dialog, where you can set the target 
resolution in pixels per inch for the current photo or all photos.  

 Swap the current photo for another photo, preserving the size, location, 
and some formatting options.  

 Remove any formatting applied to the picture. Or, click the drop-down 
arrow to reset both formatting and size.  
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Picture Styles Group 
Use this group to apply a border to the photo. 
 

Picture Styles Gallery 

 

Click a style to apply it. You can also navigate through the 
gallery with the up and down arrows, or expand the gallery 
with the More arrow.  

 Click the Picture Border command to apply the color shown 
to the outline of the border. Or, click the drop-down arrow to 
choose a different color. You can also set the border weight 
and type with the drop-down menu.  

 This button opens a menu of effects. You can choose a preset 
effect or customize various types of effects, including 
shadows, reflections, glows, soft edges, bevels, and 3-D 
rotations. (Some types of effects will cancel other effects.)  

 Change the picture’s layout to a SmartArt diagram. (We’ll 
look at SmartArt later on.)  

Option  Button Open the Picture Corrections tab of the Format Picture dialog. 
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Arrange Group 
This group will help you place the photo in the document and lay out pictures. 
 

 

Change the position of the picture on the page.  

 

Change how text interacts with the picture.  

 Click this button to bring the picture forward one level in a pile. Click the 
drop-down arrow to bring the picture to the top level (Bring to Front).  

 Click this button to send the picture backwards one level in a pile. Click the 
drop-down arrow to bring the picture to the bottom level (Send to Back).  

 Toggle the Selection Pane on or off. 

 Opens a menu with alignment and distribution commands and options, as 
well as grid settings.  

 Group, ungroup, or regroup pictures.  

 View rotation and flipping commands. The menu also has a command to 
set advanced rotation options via the Format Picture dialog. 

 
Size Group  
These commands will allow you to change the size of the picture. 
 

 

Click the Crop command to view cropping handles on your photo. Or, 
click the drop-down arrow to perform advanced cropping.  

 
Enter an exact dimension for the height of the picture, or use the up or 
down arrows to nudge the picture size in that direction.  

 
Enter an exact dimension for the width of the picture, or use the up or 
down arrows to nudge the picture size in that direction. 

Option  Button Open the Size tab of the Format Picture dialog. 
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Overview of the Pictures Mini Toolbar  
 
Another handy tool is the mini toolbar for photos, which will appear if you right-click a photo: 
 

 
 

As you can see, the mini toolbar provides quick access to common picture commands. There 
are more options on the right-click menu:  

 

Single Photo Selected Multiple Photos Selected 

 

 

 
Keep these tools in mind when you’re performing photo editing tasks.  
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Working with Images 
 
Here are some additional tips for working with photos: 

 Pictures can be cut, copied, and pasted just like regular text. 
 Pictures can also be dragged and dropped like regular text.  
 Click a picture to select it. Hold the Ctrl key and click multiple pictures to select them as 

a group. 
 Use the Select Objects command on the Home tab to make selecting images easier. 
 You can use the Format Painter to copy formatting from one image to another. 
 Deleting a photo is the same as deleting text: click it to select it and press the Backspace 

key. 
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Lesson 1.2: Editing Pictures 
 

 
Now that we know how to add different types of pictures, we’re going to learn how to edit 
them once they’re in your document. In this lesson, we’ll cover the basics, including resizing, 
moving, and arranging pictures; using grouping tools; and setting position and text wrapping 
options. 

Resizing Pictures 
 
To resize a picture, first click it to select it. Then, click and drag any of the handles to resize the 
photo in that direction:  
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As you drag the handles, you will see the photo become larger or smaller, depending on the 
direction that you drag in: 
 

 
 
Square handles resize the shape in one direction; round handles resize the shape in two 
directions. 
 
You can also enter exact dimensions in the Size group of the Picture Tools – Format tab: 
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Moving Pictures 
 
To change a picture’s location on the page, click it to select it. Then, drag and drop it to its new 
home:  
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Changing Text Wrapping 
 
The way that a picture interacts with the text around it is controlled by text wrapping options. 
To change text wrapping, select the picture and click Picture Tools - Format – Wrap Text:  
 

 
 
You can see that each option shows a small preview of what the image and text will look like 
with the icon.  
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The current text wrapping method will be highlighted, and new options will be previewed as 
you mouse over them: 
 

 
 
Note that all styles except In Line with Text allow you to drag the image wherever you want on 
the page. 
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Changing Picture Position on the Page 
 
You can also use the Position menu to choose how to place the picture on the page and have 
Word automatically set text wrapping. Once again, the icon next to each command will show 
you how that command works, and you will see a preview as you mouse over each option:  
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The More Layout Options command will open the Position tab of the Layout dialog: 
 

 
 

This dialog allows you to precisely control the position, wrapping, and size of each picture. 
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Arranging Pictures 
 
Microsoft Word offers several commands to help you position pictures (and other objects) just 
the way you want. Take a look at this example: 
 

 
 

If we want the penguin to go behind the jellyfish, we can click the red arrow and click Send 
Backward on the Picture Tools – Format tab: 
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Here is the result: 
 

 
 
If we wanted to send the penguins behind both pictures (in other words, all the way to the back 
of the pile), we could have clicked the drop-down arrow and clicked Send to Back: 
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The result would look like this: 
 

 
 
Conversely, you can also ask Word to bring pictures forward. For example, we can move our 
penguins to the middle of the pile with the Bring Forward command, or we can bring it back to 
its original position on the top of the pile with the Bring to Front command. (This option is 
accessible by clicking the drop-down arrow on the Bring Forward button.)  
 

Bring Forward Bring to Front 
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Grouping and Ungrouping Pictures 
 
Once you have your pictures arranged just the way you want them, you can group them so that 
you can move them as a single unit. This can be a real time-saver! (Note that you cannot group 
pictures that use In Line with Text wrapping.) 
 
To start, select the pictures to group by dragging a box around them or by holding Ctrl and 
clicking each picture:  
 

 
 

Then, click Group – Group on the Picture Tools – Format tab or right-click the pictures and 
choose Group – Group:  
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The pictures can now be manipulated as one: 
 

 
 

If you want to edit an individual picture, use the Ungroup command on the Picture Tools – 
Format tab or the right-click menu:  
 

Picture Tools – Format tab Right-Click Menu 
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Lesson 1.3: Doing More with Pictures 
 

 
Now that we have a handle on how to insert pictures and perform basic editing tasks, we’ll 
learn how to perform some more advanced editing tasks. Our topics in this lesson will include 
cropping, aligning, distributing, rotating, and flipping pictures.  

Cropping Pictures 
 
Word provides tools to remove areas of your photo. To start, click the picture to select it. Then 
click Picture Tools – Crop:  
 

 
 
Now, crop handles will appear on each side of the image: 
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Click and drag these handles to remove part of the photo, like this: 
 

 

Advanced Cropping Tools 
 
If you click the drop-down arrow on the Crop command on the Picture Tools – Format tab, you 
will see advanced cropping options: 
 

 
 

These options are new for Word 2010. Let’s look at each of them. The first option is for simple 
cropping, which we just looked at.  
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The next command is Crop to Shape, which allows you to pick a shape for cropping:  
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Here, we have cropped the tulips into a diamond shape: 
 

 
 

The next command is Aspect Ratio, which allows you to crop a picture for a particular 
height/width ratio:  
 

 
 

The last two commands are Fill and Fit. Fill will resize a picture so that the original area is filled, 
while Fit will fit all picture content inside the cropped area. Aspect ratio will always be 
maintained, meaning that the picture won’t look stretched or warped.  
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Rotating Pictures 
 
To rotate a picture, click and drag the green handle:  
 

 
 

Or, select a picture and use the Rotate options on the Picture Tools – Format tab or the mini 
toolbar: 
 

 
 

You can also see options here to flip the picture around vertically or horizontally.  
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The More Rotation Options command will open the Layout dialog to the Size tab: 
 

 
 

Enter a specific degree of rotation in the highlighted field and click OK to apply it. 
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Aligning and Distributing Pictures 
 
To align pictures to each other, first select the objects and then click the Align icon on the 
Picture Tools – Format tab. Now, ensure Align Selected Objects is checked:  
 

 
 
Now you can choose one of the following options from that same menu: 
 

 
 

These commands will align the left, center, right, top, middle, or bottom points of the object. 
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To align the pictures respective to the page, ensure that either the Align to Page or Align to 
Margin option in the Align menu is checked. (You only need to have one picture selected for 
this command to appear.) Now you can choose any of the Align options, which will place the 
picture(s) in the correct alignment relevant to the page or margin.  
 

 
 

You can also choose either of the Distribute options, which will space the pictures out evenly 
across the page either horizontally or vertically.  
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Lesson 1.4: Formatting Pictures 
 

 
In this lesson we’ll explore one of the major improvements to Word 2010: artistic picture tools. 
We’ll learn how to touch up pictures, apply cool effects, change a picture’s style, and even 
modify a picture’s background. We guarantee you’ll have a lot of fun! 

Correcting Pictures 
 
The first command that we will explore is the Corrections menu in the Adjust group of the 
Picture Tools – Format tab: 
 

 
 

Here, you can choose from a variety of presets to sharpen or soften the picture, and to adjust 
the brightness and contrast. The current presets will be highlighted, as shown above.  
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To manually set options for each of these categories, click the Picture Corrections Options 
command at the bottom of the menu. This will open the Picture Corrections tab of the Format 
Picture dialog: 
 

 
 

Notice that you can choose a preset for each category or use the slider to set each option. 
There is also a Reset command that will become available after you make changes. 
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Recoloring Pictures 
 
Next, let’s look at the Color menu, also found in the Adjust group of the Picture Tools – Format 
tab: 
 

 
 

Once again, we have several categories of presets: Color Saturation, Color Tone, and Recolor. 
You can click any of the presets to apply them; the current presets are highlighted in orange. 
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To recolor the picture with a color not shown here, click More Variations and choose a color: 
 

 
 

Notice that the swatches will depend on the currently selected theme. 
 
The next option in the Color menu, Set Transparent Color, will allow you to mark a color to be 
made transparent for the whole image. Here, we have clicked the Set Transparent Color 
command and are selecting a shade of green to be made transparent:  
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Here are the results: 
 

 
 
Finally, you can click the Picture Color Options command at the bottom of the menu to open 
that area of the Format Picture dialog: 
 

 
 

This dialog provides much finer control over saturation, tone, and color options. You will also 
find a Reset command to reverse any changes that you have made to the current preset(s).  
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Applying Artistic Effects  
 
Finally, the Artistic Effects menu will show you some presets for adding an artistic flair to your 
picture:  
 

 
 

Just click a preset to apply it. Or, click the Artistic Effects Options command at the bottom of 
the menu to open that area of the Format Picture dialog: 
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Here, you will be able to set different options for each effect, or reset the effect to its default 
appearance. 

Applying Picture Styles 
 
Next, we’re going to look at how to stylize your pictures. The easiest way is to use the preset 
styles on the Picture Tools – Format tab. Just click a picture and click a thumbnail to apply it:  
 

 
 

You can also use the up and down arrows to navigate through the gallery, or click the More 
arrow to view all styles: 
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Formatting Pictures Manually 
 
To apply a custom border, click the Picture Border command to apply the border shown, or click 
the drop-down arrow for more options:  
 

 
 

From top to bottom, your choices are: 
 A grid of theme colors 
 A row of standard colors 
 No outline 
 More Outline Colors, which will open a color palette allowing you to create a custom 

color 
 Weight, which will allow you to choose how thick or thin the line is 
 Dashes, which will allow you to customize the appearance of the line 
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You can also click Picture Effects to choose a preset effect or choose various types of effects, 
including shadows, reflections, glows, soft edges, bevels, and 3-D rotations. (Some types of 
effects will cancel other effects.)  
 

 
 

The Picture Layout command allows you to format your picture as SmartArt: 
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We’ll discuss SmartArt later on in this manual, but as you can see, it provides diagram 
templates that are easy to customize and format.  

Editing the Picture’s Background 
 
Word also features some powerful new background removal tools. To start, select a picture, 
click the Picture Tools – Format tab, and click Remove Background:  
 

 
 

This will highlight the background area to be removed in pink and open the Background 
Removal tab: 
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You can accept Word’s default assessment of what to remove, or you can click Mark Areas to 
Keep/Mark Areas to Remove and paint the picture: 
 

 
 
(Note the Delete Mark command. This acts like as an eraser so that you can remove marks that 
you have placed.)  
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Once you have finished, click the Keep Changes command. (Of course, if you have changed your 
mind, you can Discard All Changes too!) 
 

 
 
Here is the final result: 
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Lesson 1.5: Managing Pictures 
 

 
Believe it or not, we haven’t seen everything that Word can do with pictures! This lesson will 
focus on commands that you can use to manage picture files: compress, swap, reset, and 
export. We’ll also look at Word’s one-stop shop for picture settings: the Format Picture dialog. 

Using the Format Picture Dialog 
 
There are several ways to open the Format Picture dialog. The option button on the Picture 
Styles group on the Picture Tools – Format tab will open it, as will many of the menus. You can 
even right-click a picture and click Format Picture: 
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Here is what the dialog looks like: 
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Let’s review each category of options.  
 

Fill Choose fill settings for transparent areas of your picture. 
(Remember, the options below the radio buttons will change 
depending on the type of fill selected.)  
 

 

Line Color Choose the color of your picture’s border. (Remember, the options 
below the radio buttons will change depending on the type of 
outline selected.)  
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Line Style Choose the style of your picture’s outline.  
 

 

Shadow Control all aspects of your picture’s shadow.  
 

 

Reflection  Control all aspects of your picture’s reflection.  
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Glow and Soft Edges Configure a glow effect or soften the edges of your picture.  
 

 

3-D Format Create a custom 3-D effect.  
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3-D Rotation Create a custom 3-D rotation.  
 

 

Picture Corrections Sharpen or soften photos, or adjust the brightness and contrast. 
 

 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

52 

Picture Color Change the saturation, tone, or color scheme of pictures.  
 

 

Artistic Effects Apply and customize special effects.  
 

 

Crop Change the picture’s position and fine-tune crop values.  
 

 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

53 

 

Text Box Options will be unavailable. 

Alt Text Specify alternative text for people with disabilities.  
 

 

 
When you have finished, click Close to apply your settings. 

Compressing Pictures 
 
Next, let’s look at our first picture management command: Compress Pictures. You’ll find this 
command in the Adjust group of the Picture Tools – Format tab: 
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When you click this command, you will see the following dialog: 
 

 
 

The first option indicates that these options will apply only to this picture; uncheck it if you 
want these settings to apply to all photos in the document. The second option allows Word to 
delete cropped areas of pictures. (If you’re done editing a picture, this is a good way to trim 
down the size of a file.)  
 
Then, you have options to set the resolution of your pictures in dots per inch (dpi):  
 

 
 

Normally, you won’t need to change these settings, but they can be useful if you need to 
reduce a document’s size to e-mail it or to print it. Once you’ve set your options, click OK to 
apply the settings or click Cancel to discard them.  
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Changing the Picture 
 
The next command that we will look at is Change Picture, also available in the Adjust group of 
the Picture Tools – Format tab: 
 

 
 

This command lets you swap out one picture for other, but will preserve the size and location of 
the original picture, as well as some formatting options.  
 
Let’s look at an example. Here we have a picture of flowers: 
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Let’s click Change Picture and choose a different image: 
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We now have a new picture that is the same size and in the same location as the old picture. 
 

 

Resetting the Picture 
 
Next, let’s look at the Reset Picture command:  
 

 
 

By default, the Reset Picture command (the button itself and the first command in the menu) 
only resets formatting changes. However, you can also choose to reset the picture and its size 
with the second command in the menu. 
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Exporting Pictures 
 
If you have made a lot of formatting changes to a picture and you want to use it outside of 
Word, you can easily do so. Simply right-click a picture and click Save as Picture:  
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You will then be prompted to choose a name and location for the picture: 
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You will now be able to view and use your picture outside of Word: 
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Section 1: Review Questions 
 

 
1. Picture editing tools are often found… 

A. On the Picture Tools – Format tab  
B. On a picture’s right-click menu  
C. On the mini toolbar for pictures 
D. All of the above 

 
2. What is the difference between square and round resize handles? 

A. Square handles maintain the aspect ratio; round handles do not 
B. Square handles resize the shape in one direction; round handles resize the shape in 

two directions 
C. Square handles appear on Clip Art while round handles appear for pictures and 

screenshots 
D. There is no difference 

 
3. The Corrections menu on the Picture Tools – Format tab contains commands to… 

(Select all that apply) 
A. Sharpen and soften photos 
B. Change the saturation level of photos 
C. Adjust the brightness and contrast of pictures 
D. Recolor pictures 

 
4. The green circle handle on a picture will… 

A. Delete it 
B. Resize it 
C. Rotate it 
D. Skew it 

 
5. You are trying to move an image to a blank area of the page but cannot. Why might 

this happen? 
A. The picture has been cropped 
B. The picture has a border applied 
C. The picture uses In Line with Text wrapping 
D. Any of the above could be the cause 

 
6. Which option cannot be found in the Format Picture dialog? 

A. Apply artistic effects 
B. Set crop dimensions 
C. Add border to picture 
D. Change picture dimensions 
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7. You have spent a lot of time editing and formatting a picture in Word. You would like 
to send it to a colleague without sending them the document. What is the best way to 
do this? 

A. Copy and paste the picture 
B. Save the picture as a file and e-mail it to the colleague 
C. Put the picture in a new document and send them that 
D. Images created in Word cannot be used outside of the program 

 
8. Grouping two pictures will... 

A. Allow the two images to be moved and resized as one 
B. Apply the same alignment to both 
C. Apply the same formatting to both 
D. Save them outside of Word 

 
9. You want to take a screenshot of a Web site and put it in your document. What is your 

first step? 
A. Maximize Microsoft Word 
B. Maximize the window that you want to take a picture of  
C. Click Insert – Screenshot  
D. Click Set Image Area on the Picture Tools – Format tab  

 
10. Consider the following example. Which command would we use to put the pink heart 

on top of the pile? 
 

 
A. Send to Back 
B. Send Backward 
C. Bring Forward 
D. Bring to Front 
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Section 2: Working with Shapes 
 

 
In this section you will learn how to: 

 Draw, resize, move, edit, and delete shapes 
 Use the Drawing Tools – Format tab 
 Format shapes with styles and by hand 
 Arrange, group, ungroup, align, distribute, rotate, and flip shapes 
 Add text to shapes 
 Format text inside shapes with styles and by hand 
 Use the Transform command 
 Use guidelines and grids 
 Use the Format Shape and Format Text Effects dialogs 
 Use the Selection Pane 
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Lesson 2.1: Drawing Shapes 
 

 
In this lesson, we’ll learn all about adding shapes to your document. To start, we’ll draw a shape 
and explore the Drawing Tools – Format tab. Then, we’ll look at formatting, moving, and 
resizing shapes. 

Adding and Deleting Shapes 
 
To begin, click the Insert tab and click Shapes. Then, click the shape that you want to draw:  
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Then, click and drag in the document to create the shape: 
 

 
 

You can also single-click to create a shape of default size.  
 

 
 

When you release your cursor, the shape will be selected and the Drawing Tools – Format tab 
will be accessible: 
 

 
 
To delete the shape, ensure it is selected and press the Backspace key on your keyboard.  
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Using the Drawing Tools – Format Tab 
 
Let’s take a moment to explore the Drawing Tools – Format tab, since it contains all the 
commands that we will need to work with shapes: 
 

 
 
This topic is just an introduction to the commands. We’ll explore how to use each command 
during this section. 
 
Insert Shapes Group 
The first group has three components: 
 

Shapes Gallery 

 

Click a shape. Then, click and drag in the document to draw the 
shape.  
 
You can use the up or down arrows to navigate through the gallery, 
or use the More arrow to expand the gallery.  

 Change the shape or edit its individual points.  

 Draw a text box.  

 
Shape Styles Group 
Our next group allows you to control the appearance of the shape. 
 

Shape Styles Gallery 

 

Click a thumbnail to apply that style to the shape. 
 
Use the up or down arrows to navigate through the gallery, 
or use the More arrow to expand the gallery.  

 Click the bucket icon to apply the color shown as the fill of 
the shape. Or, click the drop-down arrow to choose a 
different color, or a picture, gradient, or texture. .  

 Click the pencil icon to apply the color shown to the outline 
of the shape. Or, click the drop-down arrow to choose a 
different color. You can also set the outline weight and type 
with the drop-down menu.  
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 This button opens a menu of effects. You can choose a preset 
effect or choose various types of effects, including shadows, 
reflections, glows, soft edges, bevels, and 3-D rotations. 
(Some types of effects will cancel other effects.)  

Option  Button Open the Fill tab of the Format Shape dialog. 

 
WordArt Styles Group 
This group is very similar to the Shape Styles group. It allows you to customize the text in the 
shape. 
 

WordArt Styles Gallery 

 

Click a thumbnail to apply that style to the text in the shape. 
 
Use the up or down arrows to navigate through the gallery, 
or use the More arrow to expand the gallery. .  

 Click the “A” icon to apply the color shown as the fill of the 
text. Or, click the drop-down arrow to choose a different 
color, or a picture, gradient, or texture.  

 Click the pencil icon to apply the color shown to the outline 
of the text. Or, click the drop-down arrow to choose a 
different color. You can also set the outline weight and type 
with the drop-down menu.  

 This button opens a menu of effects. You can choose a preset 
effect or choose various types of effects, including shadows, 
reflections, glows, bevels, 3-D rotations, and transformations. 
(Some types of effects will cancel other effects.)  

Option  Button Open the Format Text Effects dialog. 

 
Text Group  
The next group lets us control different aspects of text in text boxes. 
 

 Change the direction of text and open the Text Direction dialog.  

 Change the vertical alignment of text.  

 Link or unlink text boxes.  
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Arrange Group 
The fifth group allows us to arrange shapes and objects. 
 

 Click this button to bring the shape forward one level in a pile. Click the 
drop-down arrow to bring the shape to the top level (Bring to Front).   

 Click this button to send the shape backwards one level in a pile. Click the 
drop-down arrow to bring the shape to the bottom level (Send to Back).  

 Toggle the Selection Pane on or off. 

 Opens a menu with alignment and distribution commands and options, 
as well as grid settings.  

 Group, ungroup, or regroup shapes.  

 View rotation and flipping commands. Also has a command to set 
advanced rotation options.  

 
Size Group 
The last group lets us enter specific dimensions for the height and width of the shape. 
 

 Enter an exact dimension for the height of the shape, or use the up or 
down arrows to nudge the shape size in that direction.  

 Enter an exact dimension for the width of the shape, or use the up or 
down arrows to nudge the shape size in that direction. 

Option  Button Open the Size tab of the Layout dialog. 
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Formatting Shapes with Styles  
 
To apply a style to a shape, ensure it is selected. Then, click a thumbnail in the Shape Styles 
gallery. You will see a preview as you mouse over each thumbnail:  
 

 
 
Remember, you can use the up or down arrows to navigate through the gallery: 
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You can also use the More arrow to expand the gallery and view all styles: 
 

 
 

The styles available will depend on the theme currently selected. Likewise, the appearance of 
the shape will change if it is formatted with a style and you change the theme.  

Formatting Shapes Manually 
 
Even if you apply a style, you can customize the fill, outline, and effects of a shape. 
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First, let’s look at the Shape Fill command. You can click the bucket icon to fill the shape with 
the color shown, or you can click the drop-down arrow to choose a new color:  
 

 
 
From top to bottom, your options are: 

 A grid of theme colors 
 A row of standard colors 
 No Fill 
 More Fill Colors, which will open a color palette allowing you to choose any color 
 Picture, which will allow you to choose a photo from your computer as the background 
 Gradient, which will open a menu showing various gradients, plus a command to open 

the Fill tab of the Format Shape dialog (where you can create a custom gradient) 
 Texture, which will open a menu showing various textures, plus a command to open the 

Fill tab of the Format Shape dialog (where you can create a custom texture)  
 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

72 

The next menu is Shape Outline. Just like the Shape Fill menu, you can click the pencil icon to 
outline the shape with the color shown, or you can click the drop-down arrow to choose a new 
color and to choose the style of the outline:  
 

 
 

From top to bottom, your options are: 
 A grid of theme colors 
 A row of standard colors 
 No outline 
 More Outline Colors, which will open a color palette allowing you to choose any color 
 Weight, which will open a menu allowing you to choose the thickness of the line in 

pixels, plus a command to open the Line Style tab of the Format Shape dialog (where 
you can create a custom line) 

 Dashes, which will open a menu allowing you to choose a dashed style for the line, plus 
a command to open the Line Style tab of the Format Shape dialog  

 Arrows, which will open a menu allowing you to apply various arrow styles to the line, 
plus a command to open the Line Style tab of the Format Shape dialog  
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Finally, we have the Shape Effects menu. Here you can choose a preset effect or various types 
of effects, including shadows, reflections, glows, soft edges, bevels, and 3-D rotations. (Some 
types of effects will cancel other effects.)  
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Resizing Shapes  
 
You can resize shapes the same way as any other object. Take a look at this arrow shape:  
 

 
 

To resize the shape, we can click and drag any of the white handles to resize the shape in that 
direction: 
 

 
 

Square handles resize the shape in one direction; round handles resize the shape in two 
directions. 
 
Or, we can enter the size directly into the fields on the Drawing Tools – Format tab: 
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Some shapes will also have a yellow diamond. Click and drag it to skew parts of the image:  
 

 

Moving Shapes  
 
To move the shape, click and drag it to its new location:  
 

 
 

To create a copy of the shape, hold the Ctrl key while you are dragging.  
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Lesson 2.2: Working with Shapes 
 

 
Now that we have a handle on how to create shapes and perform basic editing tasks, we’ll learn 
how to perform some more advanced tasks. Our topics in this lesson will include editing, 
arranging, grouping, ungrouping, aligning, distributing, rotating, and flipping shapes.  

Editing Shapes 
 
There are a few commands that you can use to edit existing shapes. Here we have created and 
formatted a triangle: 
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To change the shape of the triangle, select it, click the Drawing Tools – Format tab, click the Edit 

Shape command ( ), and click Edit Points:  
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This command is also available on the right-click menu: 
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Small black handles will now appear on each point of the triangle. You can click and drag these 
handles to change the appearance of the shape: 
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To change the shape entirely, click Drawing Tools – Edit Shape – Change Shape, and choose the 
new shape:  
 

 
 

This is a useful command if you have formatted and edited the shape just the way that you 
want, as it preserves shape formatting and size: 
 

 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

81 

Arranging Shapes 
 
Word offers several commands to help you position shapes just the way you want. Take a look 
at this example: 
 

 
 

If we want the red arrow to go behind the purple star, we can click the red arrow and click Send 
Backward on the Drawing Tools – Format tab: 
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Here is the result: 
 

 
 

If we wanted to send the shape all the way to the back of the pile, we could have clicked the 
drop-down arrow and clicked Send to Back: 
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The result would look like this:  
 

 
Conversely, you can also ask Word to bring shapes forward. For example, we can move our red 
arrow to the middle of the pile with the Bring Forward command, or we can bring it back to its 
original position on the top of the pile with the Bring to Front command. (This option is 
accessible by clicking the drop-down arrow on the Bring Forward button.)  
 

Bring Forward Bring to Front 
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Grouping and Ungrouping Shapes 
 
Once you have your shapes arranged just the way you want them, you can group them so that 
you can move them as a single unit. This can be a real time-saver!  
 
To start, select the shapes to group by holding Ctrl and clicking each shape:  
 

 
 
Then, click Group – Group on the Drawing Tools – Format tab or right-click the shapes and 
choose Group – Group:  
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The shapes can now be manipulated as one: 

 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

86 

If you want to edit an individual shape, use the Ungroup command on the Drawing Tools – 
Format tab or the right-click menu:  
 

Drawing Tools – Format tab Right-Click Menu 

 

 

 
To restore the group, select all shapes and perform the Group command again, or just click one 
shape and click Regroup (located in the Group menu on the Drawing Tools – Format tab).  
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Aligning and Distributing Shapes 
 
Word also offers some ways to help you line up your objects with each other or with the page.  

 
To align shapes to each other using the menu commands, first select the objects and then click 
Align on the Drawing Tools – Format tab. Now, ensure Align Selected Objects is checked:  
 

 
 
Now you can choose one of the circled options from that same menu: 
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These commands will align the left, center, right, top, middle, or bottom points of the objects. 
 
To align the shapes respective to the page, ensure that Align to Page or Align to Margin in the 
Align menu on the Drawing tab is checked (depending on how you want the objects aligned). 
(You only need to have one object selected for this command to appear.)  
 

 
 

Now you can choose any of the Align options, which will place the shape(s) in the correct 
alignment relevant to the page.  
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You can also choose either of the Distribute options, which will space the shapes out evenly 
across the page either horizontally or vertically:  
 

 

Rotating and Flipping Shapes  
 
To rotate a shape, click and drag the green handle:  
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Or, select a shape and use the Rotate options on the Drawing Tools – Format tab: 
 

 
 

You can also see options here to flip the shape vertically or horizontally. You can also click More 
Rotation Options to open the Format Shape dialog to the Size tab:  
 

 
 

Here, you can enter a specific degree of rotation in the highlighted field. Click Close to apply 
your changes. 
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Lesson 2.3: Working with Text and Shapes 
 

 
So far, we’ve learned the basics of adding shapes to your document. In this lesson, we’ll learn 
how to use text with shapes to make a big impact. 

Adding Text to Shapes 
 
To add text to a shape, right-click the shape and click Add Text or Edit Text:  
 

 
 

(The command will differ with different types of shapes.) 
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Then a cursor will appear inside the shape. Type your text: 
 

 
 

You can click the text at any time after adding it to make changes or format it.  

Formatting Text with Styles 
 
Word provides some pre-formatted styles that you can format shape text with. First, select the 
text. Then, click a thumbnail in the WordArt Styles group:  
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Remember, you can use the up or down arrows to navigate through the gallery: 
 

 
 

Or, use the More arrow to expand the gallery and view all styles: 
 

 
 
Remember, the appearance of the text will change if it is formatted with a style and you change 
the document’s theme.  
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Formatting Text Manually 
 
To choose effects manually, use the Text Fill, Text Outline, and Text Effects commands to the 
right of the WordArt Styles gallery: 
 

 
 

Like other commands, you can click the icon to apply the settings shown, or click the arrow to 
view a menu of choices.  
 

Text Fill Text Outline Text Effects 
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You can also use the commands on the Font and Paragraph groups of the Home tab to format 
text in shapes:  
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Using the Transform Command 
 
We’d like to point out a particular command in the Effects menu: Transform. This command will 
change the path that text follows. Since transforms always apply to all text in a shape, just click 
to place your cursor inside the text that you want to change. Then, click Drawing Tools – Text 
Effects – Transform:  
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Now choose the transformation to apply. You will see a preview applied to your text as you 
mouse over each choice: 
 

 
 
To remove a transform, select the text, and click Text Effects – Transform – No Transform.  
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Lesson 2.4: Advanced Shape Tasks 
 

 
Now that we have a handle on how to create shapes, edit them, add text, and perform basic 
formatting tasks, we’ll learn how to use some advanced tools. Our topics in this lesson will 
include using grids and guidelines, the Format Shape dialog, the Format Text Effects dialog, and 
the Selection Pane. 

Using Guidelines and Grids 
 
If you need help precisely aligning shapes in your document, you might be interested in the grid 
and guideline options available. You can find these two commands in the Align menu: 
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The first option, View Gridlines, toggles gridlines on or off in your document: 
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The second option, Grid Settings, opens the Drawing Grid dialog: 
 

 
 

This dialog allows you to customize snap settings (which automatically aligns objects when they 
are within a certain range of other objects) and various aspects of the grid. You can also click 
Set As Default to make this grid the default for all documents. 

Using the Format Shape Dialog  
 
Let’s take a closer look at the Format Shape dialog. The easiest way to open it is by clicking the 
option button in the Shape Styles group of the Drawing Tools – Format tab: 
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The Format Shape dialog looks like this: 
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Let’s review its options. 
 

Fill Choose fill settings for your shape.  
 

 
 

The options below the radio buttons (circled in red) will change 
depending on the fill type selected. 

Line Color Choose the color of your shape’s outline.  
 

 
 

Once again, the options below the radio buttons will change 
depending on the fill type selected. 
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Line Style Choose the style of your shape’s outline.  
 

 

Shadow Control all aspects of your shape’s shadow.  
 

 

Reflection  Control all aspects of your shape’s reflection. 
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Glow and Soft Edges Configure a glow effect or soften the edges of your shape.  
 

 

3-D Format You can use these options to create a custom 3-D effect. 
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3-D Rotation Create a custom 3-D rotation.  
 

 

Picture Corrections Sharpen or soften photo fills, or adjust the brightness and contrast.  
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Picture Color Here you can change the saturation, tone, or color scheme of photo 
fills.  
 

 

Artistic Effects With these options you can apply special effects to photo fills. 
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Crop If a picture is being used as the fill, you can use these options to 
change the picture’s position and to crop it.  
 

 

Text Box If the shape contains text, you can modify text box options.  
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Alt Text Here you can specify alternative text for people with disabilities.  
 

 

 
When you have finished, click Close to apply your settings. 
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Using the Format Text Effects Dialog  
 
To open the Format Text Effects dialog, click the option button in the WordArt Styles group:  
 

 
 

The Format Text Effects dialog is similar to the Format Shape dialog: 
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Let’s review the options.  
 

Text Fill Choose fill settings for your text.  
 

 

Text Outline Choose the color of your text’s outline.  
 

 

Outline Style Choose the style of your text’s outline. 
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Shadow Control all aspects of your text’s shadow.  
 

 

Reflection  Control all aspects of your text’s reflection.  
 

 

Glow and Soft Edges Configure a glow effect or soften the edges of your text.  
 

 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

112 

3-D Format Create a custom 3-D effect.  
 

 

3-D Rotation Create a custom 3-D rotation. 
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Text Box Modify the alignment and direction of text, control AutoFit settings, 
change margins, and format text as columns.  
 

 

 
When you have finished, click Close to apply your settings. 

Using the Selection Pane 
 
You can toggle the Selection Pane on or off with the Selection Pane command in the Arrange 
group of the Drawing Tools – Format tab:  
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Have a look at this example: 
 

 
 

Let’s take a closer look at the Selection Pane: 
 

 
 

First, we have a list of objects on the current page. (This means that in addition to shapes, you 
will see text boxes, pictures, tables, diagrams, charts, etc.) Next to each entry is an eye icon. 
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You can click this icon to hide the object. If there is no eye in the box, click the icon to show the 
object: 
 

 
 

Also note the Show All and Hide All commands at the bottom of the pane. 
 
You can also click the object to select it, or double-click the name to rename it:  
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At the bottom of the pane, you can use the arrows to re-order shapes in the same way that we 
used the Bring to Front command (up arrow) and the Send to Back command (down arrow): 
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Section 2: Review Questions 
 

 
1. To create a default-sized shape, you would… 

A. Draw the shape and then use the AutoSize command on the Drawing Tools – Format 
tab 

B. Save your document as a Word 2003 file and then create the shape 
C. Single-click in the document instead of clicking and dragging to draw the shape 
D. Create a drawing canvas first 

 
2. A shape’s green circle handle will… 

A. Rotate it 
B. Resize it 
C. Skew it 
D. Delete it 

 
3. A shape’s yellow diamond handle will… 

A. Rotate it 
B. Resize it 
C. Skew it 
D. Delete it 

 
4. The Change Shape command will preserve what aspects of a shape? 

A. Formatting 
B. Size 
C. Location 
D. All of the above 

 
5. To create a copy of a shape, you can hold the _____ key while you are dragging it. 

A. Alt 
B. Ctrl 
C. Shift 
D. Enter 

 
6. The Transform command… 

A. Changes the path that text follows  
B. Changes the theme applied to the selected shapes 
C. Applies the same formatting to all shapes 
D. Changes the WordArt styles available 
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7. The Distribute commands will… 
A. Make all shapes the same size 
B. Create a pattern of shapes on a page 
C. Align shapes 
D. Space the shapes out evenly across the page  

 
8. You can show or hide the Selection Pane from which tab? 

A. Home 
B. View 
C. Drawing Tools – Format  
D. All of the above 

 
9. Which of the following items is not a category in the Format Text Effects dialog? 

A. Text Fill 
B. Text Effects 
C. Reflection 
D. Text Box 

 
10. Which of the following tools can be used to format shape text? 

A. WordArt Styles 
B. Text fill, outline, and/or effects menus 
C. Home tab tools 
D. All of the above 
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Section 3: Working with Advanced Graphics and Objects 
 

 
In this section you will learn how to: 

 Insert pre-defined text boxes 
 Draw text boxes 
 Edit, format, and link text boxes 
 Insert, edit, and format WordArt  
 Add SmartArt 
 Add text and pictures to SmartArt 
 Resize, move, and delete a diagram 
 Use the SmartArt Tools tabs 
 Change a  diagram’s layout, color scheme, and/or effects scheme 
 Reset SmartArt 
 Add a watermark to a document 
 Create and save custom watermarks 
 Insert, add, and manage Quick Parts 
 Use the Building Blocks Organizer 
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Lesson 3.1: Inserting Text Boxes 
 

 
Text boxes are a great tool for laying out documents. They are much like shapes in that they can 
be formatted and customized. However, there are many other tools available to help you 
manage large amounts of text. In this lesson we’ll learn all about how to insert, draw, format, 
edit, and link text boxes. 

Inserting a Pre-Defined Text Box 
 
Microsoft Office Word 2010 includes a number of pre-defined text boxes. To add one of these 
to your document, click the Insert tab, click Text Box, and choose the type of box that you want:  
 

 
 

Note that you can scroll up or down to view the entire list. The options shown will depend on 
the theme that is currently selected. 
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Once you have found a box that you like, click it. This will insert the text box into your 
document: 
 

 
 
Now you can click inside the box and type your text:  
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Drawing a Text Box 
 
To create a simple text box, click the Insert tab, click Text Box, and click Draw Text Box:  
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Your cursor will turn into a crosshair; simply click and drag to create the text box.  
 

 
 

Once you have finished, you can type in the box.  
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Common Text Box Editing Tasks 
 
Text boxes are a lot like other Word shapes in that there are many things that you can do with 
them. Let’s look at a few of the most common tasks. 
 
To move a text box, first click it to select it. Then, drag it to place it wherever you want:  
 

 
 
To resize a text box, select it, place your cursor over any of the blue handles, and click and drag:  
 

 
 
Remember, square handles will resize the box in one dimension, while round handles will resize 
the box in two dimensions. 
 
You can also use the Size group on the Drawing Tools – Format tab to enter exact dimensions: 
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To rotate a text box, click it to select it, and then drag the green handle:  
 

 
 
To delete the box, click it to select it and then press Delete on your keyboard.  

Formatting Text Boxes 
 
You can use the Shape Styles and WordArt styles groups on the Drawing Tools – Format tab to 
change the appearance of the text box and its contents just as you would a shape:  
 

 
 
You can even use the tools on the Home tab to change the formatting of the contents of the 
text box.  
 
You can also use the Text group to change the alignment and direction of the shape:  
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Last but not least, you can use the Change Shape command to make your text box a shape 
other than a rectangle: 
 

 

Linking Text Boxes 
 
If you’re creating a story type of document (such as a newsletter), you can create multiple text 
boxes and link them. This way, when there is too much text for one text box, it will overflow 
into the other box.  
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To link text boxes, click the first box and click the Create Link button on the Drawing Tools – 
Format tab: 
 

 
 
Notice how there is too much text in the first text box to be displayed. Also notice the detailed 
Screen Tip that appears when you hover over the Create Link button. 
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Then, click a second, empty text box: 
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Now the boxes will be linked. Notice how the text flows from one box to the next: 
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To break the link, select one of the boxes and click the Break Link command on the Text Box 
Tools tab. Note the warning that states all text will be placed in the selected text box:  
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Lesson 3.2: Inserting WordArt 
 

 
WordArt is a great tool that turns regular text into art! In this lesson, we’ll look at inserting 
WordArt, editing WordArt text, using WordArt styles, and formatting WordArt. 

Inserting WordArt 
 
If you want to insert specialized text without the shape, click Insert – WordArt and choose a 
style: 
 

 
 

Then, you will be prompted to type your text. You will also see the Drawing Tools – Format tab: 
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Common WordArt Editing Tasks 
 
WordArt is a lot like other Word shapes in that there are many things that you can do with 
them. Let’s look at a few of the most common tasks. 
 
To move WordArt, first click it to select it. Then, drag it to place it wherever you want:  
 

 
 
To resize WordArt, select it, place your cursor over any of the blue handles, and click and drag:  
 

 
 
Remember, square handles will resize the box in one dimension while round handles will resize 
the box in two dimensions. 
 
You can also use the Size group on the Drawing Tools – Format tab to enter exact dimensions: 
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To rotate WordArt, click it to select it, and then drag the green handle:  
 

 
 

To edit the text, just click inside the WordArt and type:  
 

 
 
 
To delete WordArt, click it to select it and then press Backspace on your keyboard.  

Adding an Outer Border to WordArt  
 
You can use the commands in the Shape Styles group of the Drawing Tools – Format tab to add 
a fill, outline, and/or effects scheme to the outer border of the WordArt:  
 

 
 

This will essentially make it into a text box with stylized text.  
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Formatting WordArt with Styles 
 
You can change the appearance of WordArt with the WordArt Styles group on the Drawing 
Tools – Format tab: 
 

 
 

The easiest method is to click a style in the gallery (circled in the image above). You can use the 
arrows to navigate through the styles or click the More arrow to see all styles:  
 

 

Formatting WordArt Manually 
 
To create a custom look for WordArt, use the Text Fill, Text Outline, and Text Effects commands 
to the right of the WordArt Styles gallery: 
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Like other commands, you can click the icon to apply the settings shown, or click the arrow to 
view a menu of choices.  
 

Text Fill Text Outline Text Effects 

 

  

 
You can also use the commands on the Font and Paragraph groups of the Home tab to format 
WordArt text.  
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Lesson 3.3: Creating SmartArt 
 

 
Our next two lessons will focus on SmartArt. SmartArt is Microsoft’s intelligent way of adding 
diagrams to your Office documents! In this lesson, we’ll cover the basics of SmartArt: how to 
add, move, resize, and delete it; how to add photos and text to it; and how to use its two 
contextual tabs. 

Adding SmartArt 
 
To add SmartArt to a document, click Insert – SmartArt: 
 

 
 
Then, choose the category of diagram that you want to insert, and then click the thumbnail for 
the specific diagram to add: 
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When you click OK, the diagram will appear in your document: 
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Adding Text 
 
To add text to the diagram, simply click where it says [Text] and type:  
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Word will adjust the size of the text as you add more information. 
 
If you prefer, you can also add text with the Text Pane. To toggle it on (or off), click the arrows 
on the side of the diagram or use the Text Pane command on the SmartArt Tools – Design tab: 
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You can then enter text in a simple bullet format: 
 

 
 
In the Text Pane, you can press Tab to move text down a level or Shift + Tab to move text up a 
level. You can also use the commands in the Create Graphic group of the SmartArt Tools – 
Design tab to add shapes, add bullets to the information in shapes, and move text and shapes 
around:  
 

 
 
Note that different diagrams support different numbers of shapes and sub-shapes; Word will 
let you know if you exceed the supported amount.  
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Adding Photos 
 
Some graphics, like the example we’re using here, offer the option to include pictures. Just click 
the picture icon to add a photo:  
 

 
 

Next, browse to the picture, select it, and click Insert: 
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(Note that you can only choose pictures from a file, not Clip Art.) Word will then insert the 
picture in the proper size and format: 
 

 
 
You can then format the image using the tools that we learned about earlier. 

Moving, Resizing, and Deleting SmartArt 
 
You can edit the diagram just like other objects. To move it, click and drag the outer border:  
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To resize it, click and drag one of the dotted handles:  
 

 
 
To delete it, click the outer border to select the entire diagram and press Backspace on your 
keyboard.  

About the SmartArt Tools Tabs 
 
Before we go any further, let’s take a look at the two SmartArt Tools tabs. (This is just a quick 
overview of the tabs to help you find commands if you need them. We’ll cover most of these 
commands in more depth in this lesson and in the next lesson.)  
 
The first tab is Design:  
 

 
 
It has the following groups: 

 Create Graphic: Contains commands to modify the shapes and information in the 
graphic. 

 Layouts: Change the layout of the information.  
 SmartArt Styles: Change the color scheme or the overall visual style of the graphic.  
 Reset: Reset the graphic to its default formatting style. Also contains a command to 

convert it to shapes or text.  
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The second tab is Format:  
 

 
 
This should look familiar! It has the following groups: 

 Shapes: Edit the shape in 2D (only available if this is a 3D graphic), change the selected 
shape, or make the shape slightly larger or smaller.  

 Shape Styles: Choose a style for the selected shape, or manually format the fill, outline, 
and effects.  

 WordArt Styles: Choose a style for the selected text, or manually format the fill, outline, 
and effects.  

 Arrange: Send the current component forward or backward in the stack; align, rotate, or 
group the component; or view the Selection Pane. 

 Size: Set the size of the selected item. 
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Lesson 3.4: Editing SmartArt 
 

 
Just like all of the other objects that we have learned about in this course, there are almost an 
endless number of ways to customize how your SmartArt diagram looks. In this lesson, we’ll 
learn how to change the layout, style, and color of the graphic, and how to reset your changes.  

Changing the Layout 
 
To change to a different type of layout (for example, from a horizontal list to a vertical list), 
simply click a thumbnail in the Layouts group of the SmartArt Tools – Design tab. You’ll see a 
preview as you mouse over each layout:  
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As always, you can use the up and down arrows to navigate through the gallery, or click the 
More arrow to see all layouts of the current type: 
 

 
 
The More Layouts command will open the Insert SmartArt dialog so that you can choose from 
any category. 
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Changing the Color Scheme  
 
To recolor your SmartArt graphic, simply click the Change Colors command on the SmartArt 
Tools – Design tab and click a color scheme:  
 

 
 
You’ll see a preview as you mouse over each type. Like the other styles we’ve looked at, these 
colors are based on your current theme.  
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You can also modify individual shapes and text in the diagram by selecting them and using the 
tools on the SmartArt Tools – Format tab, just like we did when modifying simple shapes:  
 

 
 
Of course, you can always format text with the tools on the Home tab and the mini toolbar. 

Changing the Effects Scheme 
 
To change the effects applied to the graphic, click a thumbnail in the SmartArt Styles group:  
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If you don’t see one you like, use the up and down arrows to flip through the gallery, or use the 
More arrow to see all styles: 
 

 

Resetting the Graphic  
 
If you have made formatting changes and would like to discard them, click the Reset Graphic 
command on the SmartArt Tools – Design tab: 
 

 
 

This will return the graphic to its default color and style scheme. 
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Lesson 3.5: Using Building Blocks and Quick Parts 
 

 
In this lesson, we will learn about two tools that help to organize the various customizable 
elements that make up your document. The Building Blocks Organizer manages bibliographies, 
headers, footers, page numbers, text boxes, watermarks, table styles, Quick Parts, and 
AutoText entries. These co-ordinated, stylized elements can all be combined together to create 
a professional-looking document. (For example, you could choose a Grid title page, header, 
footer, and text box to easily create a co-ordinated look for your document.) 
 
You are probably familiar with most of these tools, but we haven’t yet looked at Quick Parts. 
This feature enables you to quickly insert customized text, such as AutoText, fields, or 
document properties.  
 
In this lesson, we’ll look at both Quick Parts and Building Blocks. We’ll also take a quick look at 
watermarks. 
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Applying Built-In Watermarks 
 
A watermark is made up of text and/or photos that are washed out and appear in the 
background of the page. To add a watermark to your document, click Page Layout – Watermark 
and click one of the thumbnails: 
 

 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

152 

If you don’t like any of the watermarks that you see, click Custom Watermark in the menu:  
 

 
 
Then, the Printed Watermark dialog will open: 
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Here, you can choose a picture or text watermark, and customize either. Here’s an example: 
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Click Apply and OK to complete the operation: 
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Creating and Saving Custom Watermarks 
 
To create and save a custom watermark, you must first set it up on the page. Here’s an 
example:  
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Then, select all elements that you want to include. Next, click the Page Layout tab, click the 
Watermark button, and click Save Selection to Watermark Gallery: 
 

 
 
You will then be prompted to create a new building block, which is where watermarks are 
stored:  
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Simply type a title, choose what gallery you want to store it in, what category the item belongs 
to, and enter a description. (We recommend leaving the last two menus at their default 
settings.) Then, click OK: 
 

 
 
You should now see your custom watermark in the Watermark menu: 
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You can click this watermark to apply it just as you would the other default watermarks. 

Inserting Quick Parts 
 
Quick Parts are reusable chunks of content, such as a company motto or a document property. 
There are three categories of Quick Parts, visible when you click Insert – Quick Parts:  
 

 
 

The options are: 
 AutoText: Customizable pieces of text that you would want to re-use, like a company 

motto or favorite saying. 
 Document Property: Controls with information about the document (based on file 

properties).  
 Field: Controls that can automatically update information, like index entries or the 

current date and time.  
 
The AutoText menu will be empty by default, but we have added an entry as an example: 
 

 
 
Just click any item to insert it. 
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The Document Property list will show you a variety of document information that you can add:  
 

 
 
Just click any item to insert it. 
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The Field command will open that dialog: 
 

 
 

These options are beyond the scope of this manual. However, if you’re looking for an advanced 
command or custom mail merge fields, this is the place to look. 

Using the Building Blocks Organizer 
 
You will also find the Building Blocks Organizer command in the Quick Parts menu: 
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This command will open a dialog showing all building blocks: 
 

 
 
You can click any building block in the list on the left to see a preview. (Click the column 
headers to sort the entries.) You can also use the list at the bottom to edit or delete the 
currently selected building block, or to insert it into the document. 
 
When you have finished working with the Building Blocks Organizer, close the dialog.  

Saving Quick Parts 
 
If you have created a custom element (such as a text box or cover page) that you want to save 
for future use, you can store it in the Building Blocks Organizer. Simply select the object and 
click the command as if you were going to insert that object. Then, click the “Save Selection…” 
command.  
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For example, here we are saving a text box:  
 

 
 
To add AutoText, select text in the document, open the AutoText menu, and click “Save 
Selection to AutoText Gallery:” 
 

 
 
Fill in the details (just as we did when saving a watermark and click OK: 
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It will now be available in the AutoText menu. 
 
You can also select any object and click Quick Parts – Save Selection to Quick Part Gallery:  
 

 
 

Just be sure that you choose the correct gallery to save it to. 
 
Note that after saving custom building blocks, you will again be prompted to save your changes 
when closing Word:  
 

 
 

Be sure to click Save or your changes will be discarded. 
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Section 3: Review Questions 
 

 
1. What tab contains the Watermark command? 

A. Home 
B. Insert 
C. Page Layout 
D. The Watermark command is not on a tab 

 
2. The styles available for text boxes, WordArt, and SmartArt depend on what setting? 

A. Current theme 
B. Font size 
C. Number of pages 
D. All of the above 

 
3. In which of the following scenarios would text box linking work? 

A. Four empty text boxes 
B. Two boxes with text 
C. First box with text, second box empty  
D. Any of the above combinations 

 
4. The Building Blocks Organizer helps you manage what kinds of objects? 

A. Cover pages 
B. Headers and footers 
C. Watermarks 
D. All of the above 

 
5. The green handle on a text box will perform what action? 

A. Resize it  
B. Rotate it 
C. Skew it 
D. Delete it 

 
6. You have formatted a SmartArt diagram extensively but you’d rather return to the 

default formatting. Which command will you use? 
A. SmartArt Tools – Design – Reset Graphic 
B. SmartArt Tools – Format  – Normal View 
C. Home – Clear Formatting 
D. Page Layout – Default  
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7. You want to insert the current author in your document. Which tool can help you do 
this quickly and automatically?  

A. Field 
B. AutoText 
C. Document Property 
D. Building Block 

 
8. Which of the following statements is false about SmartArt picture diagrams? 

A. Pictures from your computer can be used 
B. Clip Art images can be used 
C. Word will automatically resize inserted images to fit inside the SmartArt 
D. Pictures will be retained even if you reset the diagram 

 
9. You have a logo that you want to save as a watermark. What should your first step 

be? 
A. Put the logo in a Word document 
B. Ensure the logo is saved as a JPEG 
C. Click the Page Layout tab 
D. Add the logo to the Building Blocks Organizer 

 
10. How would you add text to a SmartArt diagram? 

A. Click inside the diagram and type 
B. Enter text in the Text Pane 
C. Copy and paste text into the Text Pane 
D. Any of the above 
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Section 4: Creating Tables 
 

 
In this section you will learn how to: 

 Identify the parts of a table 
 Insert a table or draw a table manually 
 Use the Table Tools contextual tabs 
 Use Quick Tables 
 Insert Excel spreadsheets into a document 
 Select and resize cells, columns, or rows 
 Move, split, and resize tables 
 Insert and delete rows and columns 
 Merge and split cells 
 Format tables with styles and by hand 
 Change cell margins and spacing 
 Change cell and table alignment 
 Sort table data 
 Use formulas in a table 
 Convert tables to text and vice versa 
 Use the Borders and Shading and Table Properties dialogs 
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Lesson 4.1: Inserting Tables 
 

 
Tables are an excellent way to organize information in your documents. In this lesson, we’ll 
learn how to add tables in a few different ways. We’ll also learn about the two contextual tabs 
that appear when working with a table. Finally, we’ll learn how to add an Excel spreadsheet to a 
document. 

Anatomy of a Table 
 
A table has rows (which go horizontally), columns (which go vertically), and cells (each small 
box). Here’s an example:  
 

 
 
This table summarizes sales data. The top row shows us the time ranges. The first column 
contains the sales areas. Then, the actual sales data is in the majority of the cells. 
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Inserting Tables 
 
To add a table to your document, click Insert – Table. Then, drag out the dimensions of the 
table on the grid and click:  
 

 
 

The table will appear in the document, ready to add text: 
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If your table is larger than the grid shown in the menu (or if you’re having trouble clicking and 
dragging), click the Insert Table command:  
 

 
 

Then, you will see the Insert Table dialog, where you can enter the number of columns and 
rows that you want in your table, and set the desired AutoFit behavior. Click OK when you are 
ready: 
 

 
 

The table will appear just as before. 
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Drawing Tables 
 
Another way to create a table is to click the Draw Table command in the Table menu:  
 

 
 

Your cursor will turn into a pencil. You can then click and drag to create the table outline: 
 

 
 
You will then need to add rows and columns manually, which we will look at in the next lesson. 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

171 

About the Tables Tools Tabs 
 
You may have noticed two new tabs appear when we inserted a table: 
 

 
 
This topic is just an introduction to the commands on these two tabs. We’ll explore how to use 
the major commands during this section. 
 
The first tab is Design (pictured above). Let’s take a look at its features.  
 
Table Style Options 
This group provides checkboxes to toggle various types of table formatting on and off. 
 

 
Table Styles Group 
Our next group allows you to control the appearance of the table. 
 

Table Styles Gallery 

 

Click a thumbnail to apply that style to the table.  
 
Use the up or down arrows to navigate through the 
gallery, or use the More arrow to expand the gallery. 

 Click the bucket icon to apply the color to the 
background of the selected cell(s) or table. Or, click the 
drop-down arrow to choose a different color, or a 
picture, gradient, or texture.  

 Click the table icon to apply the border shown to the 
outline of the selected cell(s) or table. Or, click the drop-
down arrow to choose a different color. You can also set 
the outline weight and type with the drop-down menu.  
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Draw Borders Group 
This group lets you customize the borders in the table. 
 

Pencil Style Menu:   Choose the style of pencil to use.  

Pencil Weight Menu:  Choose the weight of the line to apply.  

 Choose the pencil color to use.  

 

Toggles the pencil cursor on or off. When the pencil cursor 
is on, you can click and drag over borders to paint them.  

 

Toggles the eraser on or off. When the eraser is on, you can 
click and drag over borders to remove them.  

Option  Button Opens the Borders and Shading dialog. 
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The other Table Tools tab is Layout:  
 

 
 
Let’s look at its commands.  
 
Table Group 
This group contains commands to work with the table as a whole. 
 

 

The Select command expands into a menu to allow you to easily select the current 
table, column, or row.  

 

Toggle gridline display on or off.  

 

Open the Table Properties dialog. 

 
Rows & Columns Group 
Use this group to modify rows and columns in the table. 
 

 

The Delete command expands into a menu with commands to delete the 
current cell(s), table, column, or row.  

 

Insert a row above or below the current one.  

 

Insert a column to the left or right of the current one.  

Option  Button Opens the Insert Cells dialog.  

 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

174 

Merge Group 
Use this group to modify cells in the table. 
 

 

Merge the selected cells into one.  

 

Divide the selected cell into several cells.  

 

Split the current table into two parts.  

 
Cell Size Group 
This group allows you to modify the size of rows and columns. 
 

 

Automatically adjust the size of the table or its parts according to 
various criteria.  

 
Set the height for the selected row(s).  

 
Set the width for the selected column(s).  

 Make all rows equal height.  

 Make all columns equal width.  

Option Button Opens the Table Properties dialog. 
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Alignment Group 
Commands in this group change how text is displayed in cells. 
 

 

Set the vertical alignment of text in the selected cell(s).  

 

Choose what direction text flows in.  

 

Set the amount of white space around text.  

 
Data Group 
The final group in this tab lets you modify table data. 
 

 

Open the Sort dialog to choose how table data is sorted.  

 

Ask Word to repeat the first row of the table whenever the table flows 
onto another page.  

 

Convert the table into a list of text.  

 

Calculate the current cell based on a formula, like adding all the cells 
above it together.  
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Inserting a Quick Table 
 
Word also provides some sample tables for common tasks, called Quick Tables. To add one of 
these, click Insert – Tables – Quick Tables and click a thumbnail: 
 

 
 
The table will then be inserted and ready to modify. 
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Adding an Excel Spreadsheet 
 
If you already have your data set up in Excel (the Microsoft Office spreadsheet program), you 
can easily add it your document by clicking Insert – Table – Excel Spreadsheet:  
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You will then see a small spreadsheet window and Excel commands in the interface. Simply 
paste your Excel data into the small sheet: 
 

 
 
Once you have added the data, click a blank part of the document. Your spreadsheet will now 
be included: 
 

 
 
If you need to edit the spreadsheet, just double-click it to re-open the Excel object interface.  
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Lesson 4.2: Editing Tables 
 

 
In our last lesson, we learned how to add tables to a document. In this lesson, we’ll continue 
our journey by learning how to perform basic editing tasks: selecting, resizing, splitting, and 
moving tables; adding, deleting, and resizing rows and columns; and merging and splitting cells. 

Selecting Table Data 
 
To select a table, place your mouse over any part of the table. Then, click the four-headed 
arrow icon above the top left corner of the table:  
 

 
 

You can also simply click and drag over the table or any of its parts: 
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Last but not least, you can also use the Select menu on the Table Tools – Layout tab to select a 
table or its parts: 
 

 
 
Just as with regular text, selecting parts of a table will tell Word what you want to modify. 

Moving Tables 
 
To move a table, select it and then click and drag it to its new location:  
 

 
 
You can also cut a table and paste it into a new location. 
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Adding and Deleting Rows and Columns 
 
You will find commands to insert and delete rows and columns on the table right-click menu:  
 

 
 

And in the Rows & Columns group of the Table Tools – Layout tab: 
 

 
 
You can also select entire rows or columns and press Backspace on your keyboard to delete 
them. To delete the entire table, select it using the methods described previously and press 
Backspace on your keyboard.  
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Resizing Rows, Columns, and Tables 
 
To manually adjust the size of rows or columns, click and drag the row or column separator:  
 

 
 
You can double-click the line if you want Word to fit the row or column to its text:  
 

 
 

You can also set the height for rows and the width of columns in the Cell Size group:  
 

 
 
This can apply to all rows and columns or just those that you have selected. Or, the Distribute 
Rows command will make all selected rows the same height, while Distribute Columns will 
make all selected columns the same width.  
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You can also use the AutoFit commands to have Word automatically size your table based on 
various criteria:  
 

 

Merging and Splitting Cells 
 
There may be times when you want to merge a group of cells into one – for example, to create 
a table title. To do this, select the cells to merge and click Merge Cells on the Table Tools – 
Layout tab: 
 

 
 
Note that this command is also found on the right-click menu. 
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To split a merged cell, select the cell and then click the Split Cells command on the right-click 
menu or the Table Tools – Layout tab: 
 

 
 
Then, Word will ask you for the configuration of the split: 
 

 
 

Once you click OK, the split will be performed. 
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Splitting a Table 
 
Word also provides a tool to split a table into two parts. First, place your cursor in the row that 
you want to be first in the new table. Then, click the Split Table command on the Table Tools – 
Layout tab: 
 

 
 
You will now have two tables: 
 

 
 
To re-join them, just delete the space between them.  
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Lesson 4.3: Formatting Tables 
 

 
Now that we’ve got the basics of creating tables down, it’s time for the fun stuff! In this lesson, 
we’ll learn how to use pre-defined styles to format tables. We’ll also learn how to use manual 
formatting tools to create custom styles; format table text; and change alignment and spacing 
options. 

Applying Table Styles 
 
Table styles are the easiest way to format a table. Like other styles we’ve looked at, they’re 
based on your current theme to help you create a polished look.  
 
To apply a style, first place your cursor inside your table. Then, click one of the thumbnails in 
the Table Styles gallery on the Table Tools – Design tab. You will see a preview as you mouse 
over each thumbnail: 
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Like other style galleries we have looked at, you can click the up and down arrows to navigate 
through the available styles, or click the More arrow to see all styles: 
 

 
 
Note the Clear command which will clear the current style from the table.  
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Changing Formatting Options 
 
To change the way formatting is applied to the table, use the Table Style Options group in the 
Table Tools – Design tab: 
 

 
 

Here, you can toggle various types of formatting on or off. (Banded rows and columns will apply 
alternate shading to those elements.)  

Formatting the Table Manually 
 
You can also format the table by hand. To change the background color of one or more cells, for 
example, select the cell(s) that you want to change. Then, click the Shading menu on the Table 
Tools – Design tab and choose a color:  
 

 
 
 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

189 

This menu is also available on the mini toolbar: 
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To change border formatting, first set the desired style, weight, and color using the menus on 
the Draw Borders group of the Table Tools – Design tab: 
 

Pencil Style Pencil Weight Pencil Color 
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Then, select the cell(s) to format and use the Borders menu in the Table Styles group to choose 
what part of the border to format:  
 

 
 

(This menu is also available on the mini toolbar.) 
 
Or, click the Draw Table command and manually paint the borders that you want to change:  
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Click the Draw Table command again to toggle painting off. The Eraser command will remove 
the border altogether:  
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Formatting Table Text 
 
As a final note, you can use the commands on the Font and Paragraph groups of the Home tab 
and the mini toolbar to format table text:  
 

 
 
For a refresher on these commands, please refer to the Foundation level of this courseware. 
 
If you want to change the direction of the text, you can use the Text Direction command on the 
Table Tools – Layout tab: 
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This command acts as a toggle, with the image on the button reflecting the current direction of 
the text. 

Changing Cell Margins and Spacing 
 
To change the white space between a cell’s contents and its borders (called the margin), or to 
add space between cells, select the cells to change and click the Cell Margins command on the 
Table Tools – Layout tab: 
 

 
 

Now, you can adjust the cell margins and spacing:  
 

 
 
Click OK when you have finished entering the desired dimensions. 
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Aligning a Table and its Cells 
 
To align a table, first select it using one of the methods described previously. Then, use one of 
the alignment commands on the Home tab: 
 

 
 
You can also adjust the horizontal alignment of cells using these commands.  
 
To change both horizontal and vertical alignment, use the commands in the Alignment group of 
the Table Tools – Layout tab: 
 

 
 

All of these commands can be used on one or multiple cells. 
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Lesson 4.4: Working with Table Data 
 

 
So far, we have learned some different ways of creating and formatting tables. In this lesson, 
we will learn how to do even more with tables, including how to sort data, calculate data, 
convert tabbed text to tables and vice-versa, and use the Table Properties and Borders and 
Shading dialogs. 

Sorting Table Data 
 
The Sort command on the Table Tools Layout tab is an excellent tool for arranging data in any 
way that you want. As an example, take a look at this table:  
 

 
 

Currently, the areas appear in the order that they were entered.  
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If we wanted to sort the areas alphabetically, we could place our cursor in that column (or 
select the appropriate data) and click the Sort command on the Table Tools – Layout tab: 
 

 
 
Now, we can choose how we want to sort the data: 
 

 
 
These settings are the default; they will sort Column 1 by its text in ascending (A-Z order). 
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Here is the result: 
 

 
 

Note that Word didn’t distinguish the total row. This is why it is important to select only the 
required data. 

Calculating Data with Formulas 
 
Although Word isn’t a spreadsheet program, it does provide some basic tools for calculating 
table data. First, place your cursor in the cell that you want the total to appear. Then, click the 
Formula button on the Data group of the Table Tools – Layout tab: 
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Word will automatically choose the formula that it thinks is best; in this case, it will add up all 
the figures above the current cell, which is exactly what we want it to do:  
 

 
 

Once you click OK, the results will be inserted into the cell. If your data changes at any time, 
simply click in the cell and press F9 on your keyboard to refresh the data. 
 

 

Converting a Table to Tabbed Text 
 
Although Word does have the ability to create great tables, you may find that you need to 
move the data into another program. Although not all data programs support Word’s format, 
most programs do support plain text files (TXT) or comma separated values (CSV) files.  
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To convert a table into this type of file, first select it. Then, click Convert to Text on the Data 
group of the Table Tools – Layout tab: 
 

 
 
Then, specify how you want your data to be separated. (Typically you will want to pick tabs or 
commas.)  
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Now your table will appear as plain text: 
 

 
 

To complete the conversion, make sure to save your document as a plain text (.txt) file. 
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Converting Tabbed Text to a Table 
 
What if you have received a plain-text document and want to convert it into a table? It’s easy! 
First, select the table. Then, click the Insert menu, click Table, and click Convert Text to Table:  
 

 
 
(Note that this command will only be available if your text is properly separated.) 
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Then, specify the number of columns you want, how Word should AutoFit the text, and how 
the text is separated. (Usually Word is good at picking up on this information from the table, 
but always double-check.) Click OK when you are ready: 
 

 
 

Once you click OK, your text will be transformed into a table. You’ll have some adjusting and 
formatting to do, but it’s a start! 
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Using the Borders and Shading Dialog 
 
For advanced border and shading options, click Borders and Shading from the Borders menu. 
(Remember that you should select the cells that you want to change first.) 
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You will then see this dialog. 
 

 
 
We’ve numbered the picture so we can walk through the different methods of applying a 
paragraph border.  
 

1.  
 

Choose a setting from None, Box, All, Grid, and Custom. (Click on the graphic next to each 
setting to select it.) Each graphic represents what that setting will look like; the preview 
box marked with a 7 will also show you a sample of the current settings. 

2.  Select the border’s style. There are many styles to choose from, including wavy lines, solid 
lines, dotted lines, and patterned lines. The style list will change as you choose different 
colors and widths. 

3.  Click the drop-down arrow to select the border’s color. 

4.  Select the border’s width. The actual point sizes will vary depending on the setting you 
have chosen, but normally you can choose from ¼ point line (very thin) to a 6 point line 
(very thick). (Lines are measured in font point sizes.) 

5.  Use these buttons to apply the border to different parts of your table. 

6.  Use this drop-down menu to apply the border to the entire table or part thereof. 
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7.  This box will show you a preview of the current settings. 

8.  Click this button to choose a type of horizontal line to insert. 

 
Now let’s take a look at the Shading tab. Once again, we’ve numbered all the settings so we can 
walk through the available options.  
 

 
 

1.  First, choose the fill color from this palette. 

2.  Then, choose a style. (You can choose a shaded style or a pattern.) 

3.  Next, choose a color for your pattern. Just like using a fill, you can select a standard 
color or create your own. 

4.  Use this drop-down menu to apply the border to the entire table or part thereof. 

5.  Click this button to choose a type of horizontal line to insert. 

6.  This box will show you a preview of the current settings. 

 
Once you’re done, click OK to apply your settings. 
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Using the Table Properties Dialog 
 
The last item that we’re going to look at is the Table Properties dialog. This is a one-stop shop 
for most table settings.  
 
First, make sure that you select the portion of the table that you want to format. Then, to open 
the dialog, right-click the table and click Table Properties, or click the Table Properties 
command on the Table Tools – Layout tab: 
 

 
 
 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

208 

With either command, you will see this dialog: 
 

 
 

Let’s take a look at what each tab does. 
 

Table Set the preferred width, alignment, and text wrapping for the table. You can also 
set an indent. This tab also contains commands for the Borders and Shading 
dialog and the Table Options dialog (used to set cell margins and spacing). 

Row Specify the row height and if it is allowed to break across pages.  

Column Specify preferred column width.  

Cell Specify preferred width and alignment. Also contains an Options button, which 
opens a dialog where you can set cell margins and wrap options.  

 
Once you have entered your settings, click OK to apply them. 
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Section 4: Review Questions 
 

 
1. How would you select table data? 

A. Table selector icon that appears when you mouse over a table 
B. Click and drag over the table 
C. Select menu on Table Tools – Layout tab 
D. All of the above 

 
2. A sample table provided by Word (such as a calendar) is called a… 

A. Delimited table 
B. Quick Table 
C. Stylized table 
D. Template 

 
3. What is the first step to splitting a table? 

A. Place your cursor in the row that you want to be first in the new table  
B. Make sure your table has header rows 
C. Click the Split Table command 
D. Copy all data 

 
4. You have applied a style to your table but you don’t like the banded rows. How do you 

turn this option off?  
A. Borders and Shading dialog 
B. Table Properties dialog 
C. Uncheck “Banded Rows” on the Table Tools – Design tab 
D. Clear formatting from the row 

 
5. What tools can you use to format text in a table? 

A. Table or document styles 
B. Home tab 
C. Mini toolbar 
D. All of the above 

 
6. Where will you find the commands to change the vertical alignment of a cell? 

A. Table Tools – Layout tab 
B. Table Tools – Design tab 
C. Borders and Shading dialog 
D. Home tab 
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7. Which of the following symbols is not a default delimiter option when converting a 
table to text? 

A. Paragraph mark 
B. Colon 
C. Comma 
D. Tab 

 
8. Combining two or more cells into a single cell is called… 

A. Concatenating 
B. Producing 
C. Splitting 
D. Merging 

 
9. =SUM(ABOVE) is an example of… 

A. A formula 
B. A math problem 
C. A test 
D. A headache 

 
10. Which of the following is not a table border setting? 

A. Width 
B. Color 
C. Art 
D. Style 
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Section 5: Creating Equations and Charts 
 

 
In this section you will learn how to: 

 Add built-in equations 
 Create custom equations 
 Use the Equation Tools – Design tab 
 Save equations to the gallery 
 Insert, resize, move, and delete charts 
 Use the Chart Tools tabs 
 Edit chart data 
 Change the chart type, layout, and style 
 Add a caption to a chart 
 Analyze chart data with Trendlines, up/down bars, error bars, and other bar and line 

types 
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Lesson 5.1: Working with Equations 
 

 
In this lesson, we’re going to learn about Word’s Equation feature and the Equation Tools tab. 
We’ll focus on inserting a built-in equation, creating a custom equation, and saving equations 
for future use. 
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Inserting Built-In Equations 
 
To add an equation to your document, click the Insert tab, click Equation, and choose the 
equation that you want to use:  
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Note the scroll bars to see more equations, and the option to see more equations on 
Office.com. 

 
Once you choose an equation, you will see it in your document. The Equation Tools – Design tab 
will also become available. Simply type over the letters to insert your data: 
 

 
 

Note that Word’s equations are not functional; as you can see in the example above, “c” has 
not been calculated even though we have entered values for a and b.  
 
To change the alignment or appearance (professional vs. linear) of the equation, click the arrow 
on the right hand side of its container:  
 

 
 
The “Change to Inline” option will apply inline text wrapping, versus wrapping as a picture 
(called display wrapping).  

Using the Equation Tools – Design Tab 
 
When you have an equation selected, you will see the Equation Tools – Design tab: 
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Let’s take a look at each group. 
 

Tools Equation Provides a menu of ready-made equations that you can insert. 
The inserted equation will replace the currently selected 
equation.  

Professional Switch to professional formatting.  

Linear Switch to linear formatting.  

Normal Text Switch to normal text.  

Option Button Opens the Equation Options dialog.  

Symbols Gallery Click a symbol to insert it. You can navigate through the Symbols gallery 
using the arrows on its right hand side.  

Structures Gallery Click any of these items to see pre-built structures that you can add into 
your own equation.  

Creating a Custom Equation 
 
If you want to create an equation by hand, click Insert – Equation – Insert New Equation:  
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You will now see a blank equation container and the Equation Tools – Design tab: 
 

 
 

You can now click elements in the Symbols and Structures groups to add them to your 
equation. You can also type letters on your keyboard to add variables.  

Saving an Equation to the Gallery 
 
If you have created a custom equation that you plan to use again, you can save it to the 
equation gallery. First, select the equation that you want to save. Then, click the Equation 
button on either the Insert tab or the Equation Tools tab, and click Save Selection to Equation 
Gallery:  
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You can also find this command on the equation options menu: 
 

 
 

With any of the Save commands, you will be prompted to enter details about the equation.  
 

 
 

Once you click OK, your equation will be saved as a building block. Remember to confirm the 
changes to building blocks when you close Word.  
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Lesson 5.2: Creating Charts 
 

 
Tables are a great way to summarize data, but sometimes a picture is worth a thousand words! 
In this lesson, we’ll learn how to add charts to your document and how to edit and format 
them. 

Inserting a Chart 
 
To start, determine where your data is going to come from. If it is already in your document (or 
in another location), copy it. If you still have to enter the data, that’s OK too – we can do it after 
creating the chart.  
 
Next, click to place your cursor where you want the chart to go and click Insert – Chart:  
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You will then be prompted to choose the type of chart: 
 

 
 

We will choose a basic line chart and click OK. You will now see a Microsoft Excel window on 
top of the Word window: 
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Now, you can paste the data into the Excel sheet or enter it by hand:  
 

 
 
If you are entering it by hand, you can make the source data larger or smaller by clicking and 
dragging the blue border. Once you have finished editing the data, close the Excel window.  
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Check out your Word chart! 
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Moving, Resizing, and Deleting Charts 
 
You can edit the chart just like other objects. To move it, click and drag the outer border:  
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To resize it, drag one of the dotted handles:  
 

 
 
To delete it, click the outer border to select the entire chart and press Backspace on your 
keyboard.  

About the Chart Tools Tabs 
 
Let’s take a quick look at the three Chart Tools tabs. The first tab is Design:  
 

 
 
The groups are: 

 Type: Change the chart type or save the current type as a template. 
 Data: Select, edit, or refresh data, or change how data is displayed. 
 Chart Layouts: Change the way the chart is organized. 
 Chart Styles: Change the appearance of the chart. 
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Next we have the Layout tab:  
 

 
 
The groups are: 

 Current Selection: Choose what part of the chart to format, open the Format dialog for 
that component, or reset the component. 

 Insert: Add pictures, shapes, or a text box to your chart. 
 Labels: Add labels to different parts of the chart. 
 Axes: Change the appearance and labels of the axes and gridlines. 
 Background: Format the chart wall and floor and the part area. You can also modify 3-D 

rotation options. 
 Analysis: Add lines or bars to the chart to highlight data trends. These features are not 

supported with all charts. 
 
Finally, we have the Format tab:  
 

 
 
This tab has groups for: 

 Current Selection: Choose what part of the chart to format, open the Format dialog for 
that component, or reset the component. 

 Shape Styles: Choose a style for the selected component, or manually format its fill, 
outline, and effects. 

 WordArt Styles: Choose a style for the selected text, or manually format its fill, outline, 
and effects. 

 Arrange: Send the current component forward or backward in the stack; align, rotate, or 
group the component; or view the Selection Pane. 

 Size: Set the size of the current component. 
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Editing Chart Data 
 
If you need to make changes to the chart’s data, click the Edit Data command on the Chart 
Tools – Design tab, or right-click the chart and click Edit Data:  
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This will re-open the Excel window so that you can edit your data: 
 

 
 
As you make your changes, Word will update the chart. Just close the Excel window when 
you’re done.  
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Lesson 5.3: Formatting Charts 
 

 
Like everything else in Word, there are many ways that you can customize the appearance of 
your chart. In this lesson, we will learn how to change the chart’s type, layout, and style. We’ll 
also learn how to add captions to a chart. 

Changing the Chart Type 
 
To change the chart type (say, from a line chart to a column chart), click the chart. Then, click 
the Change Chart Type command on the Chart Tools – Design tab: 
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Now, choose the new type of chart and click OK:  
 

 
 

All chart formatting options and data will be shown in the new chart: 
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Changing the Chart’s Layout 
 
To change the layout of a chart (i.e. where the legend and other components appear), click a 
thumbnail in the Chart Layouts group on the Chart Tools – Design tab: 
 

 
 
Like other galleries that we have looked at, you can click the More arrow to show all layouts 
and choose from more thumbnails:  
 

 

Changing the Chart Style 
 

Finally, to change the overall visual appearance of a chart, click a thumbnail in the Chart Styles 
gallery of the Design tab:  
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Of course, you can see all the styles with the More arrow! 
 

 
 
Note that the styles available will depend on the currently selected theme. 
 
To change any individual component of a chart, first select by clicking it or using the menu on 
the Chart Tools – Format tab: 
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You can then use the commands on that tab and the Home tab to modify the appearance of 
that element:  
 

 
 
You can also click the Format Selection command on the Chart Tools – Format tab or double-
click a chart element to see a formatting dialog:  
 

 
 

These dialogs contain custom commands for each chart component, and provide finer control 
than is offered on the tabs.
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Note the “Reset to Match Style” command in the Current Selection group of the Chart Tools – 
Format tab, which is useful if you want to revert all changes to the chart as a whole or to a 
particular component:  
 

 

Adding Captions to a Chart 
 
Finally, to add a caption to a chart, start by selecting it. Then, click References – Insert Caption:  
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Now, type your caption and click OK: 
 

 
 
The caption will then appear with the chart: 
 

 
 
It can be edited like any other text. 
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Lesson 5.4: Analyzing Chart Data 
 

 
Although Word is not designed to analyze data, the Analysis group of the Chart Tools – Layout 
tab does provide the ability to add different types of lines and bars to your chart: 
 

 
 

In this lesson, we will look at each type of analysis tool and what it can offer for your chart.  
 
Note that the options available may differ depending on the type of chart. As well, you can add 
multiple types of lines and bars to your chart. 

Adding Trendlines 
 
The first option is Trendline. Trendlines can help you identify patterns and see what the trends 
might look like. When you click the Trendline command, you can choose from these options: 
 

 
 

Simply click the Trendline to add it, and then choose the series.  
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For example, if we wanted to see the average sales for Week 3, we would click Linear Trendline. 
Then, when prompted, we’ll choose the proper set of data: 
 

 
 
Now the Trendline will be added: 
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Note that Trendlines can be formatted just like other chart elements: 
 

 
 
To remove the Trendline, select it, click the Trendline button again, and click None: 
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Adding Other Line Types 
 
The next button in the Analysis group lets you choose some different types of lines: 
 

 
 

(Other lines may be available depending on the chart type.) Like the Trendline menu, simply 
click a line to apply it. Drop lines help show where one set of data begins and another ends: 
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High-low lines will stretch from the highest value to the lowest value: 
 

 
 
Just like Trendlines, you can format these lines to suit your chart. To remove the lines, simply 
click Lines – None. 

Adding Up/Down Bars 
 
Our next option is Up/Down Bars, which show the difference between the first data series and 
the last data series. The Up/Down Bars menu lets you toggle the bars on or off: 
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Here is an example: 
 

 
 

To format the bars, choose More Up/Down Bars Options: 
 

 
 

You can also use the commands on the Chart Tools – Format tab. 
 
To remove the bars, choose the None option from the Up/Down Bars menu. 
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Adding Error Bars 
 
Our last option is Error Bars: 
 

 
 

This menu lets you display the possible margin of error in your chart using various formulae. 
Here’s an example of the Standard Error Bars: 
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You can use the More Error Bars Options to choose the series to base the error bars on: 
 

 
 

As well, you can format the error bars just like other chart components. (If you use the More 
Error Bars Options command, you will automatically see the Format Error Bars dialog after you 
choose the series.) To remove the error bars, click None from the Error Bars menu. 
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Section 5: Review Questions 
 

 
1. You have inserted a bar chart and want to change it to a line chart. What is the easiest 

way to change the chart type? 
A. Delete the chart and start over 
B. Create a new chart in Excel 
C. Format the bars as lines 
D. Click Change Chart Type on the Chart Tools – Design tab and choose the new chart 

type 
 
2. To move a chart… 

A. Click and drag the outer border 
B. Use the Position command on the Chart Tools – Layout tab  
C. Set the X and Y axis location on the Chart Tools – Design tab 
D. Choose the correct alignment in the Insert Chart dialog 

 
3. You want to create an equation in Word but you do not see it in the built-in menu. 

What should you do? 
A. Do what you can with symbols 
B. Upgrade to Windows 7 and use the Math Input Panel 
C. Click Insert – Equation – Insert New Equation and draw it by hand 
D. Use Excel instead 

 
4. You want to create a Trendline to forecast data for a particular series, and to make it 

stand out from the rest of the chart. What is the best way to do this? 
A. Add a Linear Trendline and format it as a bar 
B. Click More Trendline Options; this will allow you to choose the series and format the 

Trendline without having to perform any additional commands 
C. Add an Exponential Trendline and drag the line to extend across the series 
D. Trendlines cannot forecast data 

 
5. Chart styles are based on the current… 

A. Document type 
B. Version of Excel 
C. Theme 
D. Page size 

 



Microsoft Office Word 2010 Advanced   

© 2005-2011 Velsoft Training Materials, Inc. 

243 

6. You would like to have the legend at the top of the chart, instead of on the left (where 
it is currently located). What is the easiest way to do this? 

A. Change the chart layout 
B. Change the chart type 
C. Change the chart theme 
D. Manually drag it outside of the chart  

 
7. Which Chart Tools tab contains the command to add a caption? 

A. Design 
B. Layout 
C. Format 
D. None of the above 

 
8. You will be using a custom equation a fair bit in the future. What is the best way to 

ensure that you can re-use it? 
A. Copy it into a blank document 
B. Save it as a building block 
C. Take a screenshot of it 
D. Upload it to Office.com 

 
9. You have found an error in your chart’s data. What is the easiest way to edit it? (Select 

all that apply.) 
A. Click the Edit Data command on the Chart Tools – Design tab  
B. Right-click the chart and click Edit Data  
C. Edit the labels in the chart itself 
D. Delete the chart and re-create it 

 
10. You would like to see a line on your chart showing the average of a data series. What 

type of analysis line will you use? 
A. Up/Down Bars 
B. Error Bars 
C. Trendlines 
D. Drop Lines 
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